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GENERAL SAFETY SUMMARY 

■ Read This before Using the Instrument 
This instrument should only be used by persons with sufficient knowledge of electronics who 

thoroughly understand the contents of this manual. 
 

This instrument is not designed or manufactured for households or ordinary consumers. 

If unqualified personnel are to use the instrument, be sure the instrument is handled under the 

supervision of qualified personnel (those who have electrical knowledge). This is to prevent the 

possibility of personal injury or damage to the instrument. 

■ Note about Reading This Manual 
The contents of this manual contain specialized terminology and may be difficult to understand. If 

you have any questions about the contents of this manual, please contact your local LEADER 

agent. 

■ Symbols and Terms 
The following symbols and terms are used in this instruction manual and on the instrument to 

indicate important warnings and notes. 

 

<Symbol> 

 

This symbol appears in this instruction manual and on the instrument to indicate an area 

where improper handling could result in personal injury, damage to the instrument, or 

malfunction of the instrument or devices connected to it. 

When you encounter this symbol on the instrument, be sure to refer to the information in 

this instruction manual that corresponds to the area that the symbol marks. 

<Term> 

 

Ignoring the precautions that this term indicates could lead to death or serious injury. 

<Term> 

 

Ignoring the precautions that this term indicates could lead to personal injury or damage 

to the instrument. 
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GENERAL SAFETY SUMMARY 

Read the warnings and cautions below thoroughly to avoid death, personal injury, and damage and 

deterioration of the instrument. 

 

 
 

■ Warnings Concerning the Case and Panels 
Do not remove the instrument's case or panels for any reason. Touching the internal components 

of the instrument could lead to fire or electric shock. 

Also, do not allow foreign materials, such as liquids, combustible matter, and metal, to enter the 

instrument. Turning the instrument on when such materials are inside it could lead to fire, electric 

shock, damage to the instrument, or some other accident. 

■ Installation Environment 
• Operating Temperature Range 

Use this instrument in a 0 to 40 °C environment. Using the instrument with its vents blocked or 

in a high temperature environment could lead to fire. 

Drastic changes in temperature, such as might be caused by moving the instrument between 

two rooms with different temperatures, can damage the instrument by causing condensation to 

form within it. If there is a possibility that the instrument has condensation within it, wait for 

approximately 30 minutes before turning on the power. 
 

• Operating Humidity Range 

Use this instrument in an environment whose relative humidity is 85 % or less where there is 

no threat of condensation forming. 

Also, do not operate this instrument with wet hands. Doing so could lead to electric shock or 

fire. 
 

• Do Not Operate in an Explosive Atmosphere 

Using this instrument in an environment where flammable gasses, explosive gasses, or steam 

is emitted or stored could lead to an explosion or fire. Do not use the instrument in such an 

environment. 
 

• Do Not Insert Foreign Materials 

If foreign materials, such as metal, flammable objects, or liquid are allowed into the instrument 

(through the vents for example), fire, electric shock, damage to the instrument, or some other 

accident may result. 

■ If You Notice Something Wrong during Operation 
If you notice smoke, fire, a strange smell, or something else that is wrong with the instrument 

while you are operating it, stop operation immediately, and remove the power cord plug from the 

outlet. Failing to do so could lead to fire. After making sure that fire has not spread anywhere, 

contact your local LEADER agent. 
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GENERAL SAFETY SUMMARY 

 
 

■ Warnings Concerning the Power Source 
Do not use a power source with a voltage other than the rated power source voltage for the 

instrument. Doing so could lead to fire. 

Confirm the voltage of the power source before you connect the power cord to it. 

Only use a power source whose frequency is 50/60 Hz. 
 

Use a power cord that is appropriate for the voltage of the power source. Also, use a power cord 

that meets the safety standards of the country that you are using it in. 

Using a power cord that does not meet the standards could lead to fire. If the power cord is 

damaged, stop using it, and contact your local LEADER agent. Using a damaged power cord 

could lead to electrical shock or fire. 

When removing the plug from the power outlet, do not pull on the cord. Pull from the plug. 

  

 

 

 

 
 

■ Cautions Concerning the Input and Output Connectors 
To avoid damaging the instrument, only apply signals to the input connectors that conform to the 

specifications in this instruction manual. Do not short or apply external voltage to the output 

connectors. 

Doing so could damage the instrument. 

■ If You Will Not Use the Instrument for an Extended Period of Time 
If you will not use the instrument for an extended period of time, remove the power plug from the 

outlet. 
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GENERAL SAFETY SUMMARY 

■ Calibration and Repairs 
This instrument has been carefully examined at the factory to ensure that its performance is in 

accordance with the standards. However, because of factors such as parts wearing out over time, 

the performance of the instrument may degrade. To ensure stable performance, we recommend 

that you have the instrument calibrated regularly. Also, if the instrument malfunctions, repairs are 

necessary. For repairs and calibration, contact your local LEADER agent. 

■ Routine Maintenance 
Before you clean the instrument, remove the power plug from the outlet. 

Do not use thinner, benzene, or other solvents when you clean the instrument's case, panels, and 

knobs. Doing so could lead to paint chipping and the corrosion of plastic components. To clean the 

case, panels, and knobs, use a soft cloth with mild detergent, and wipe gently. While cleaning, 

make sure that foreign materials, such as water and detergent, do not enter the instrument. If 

liquid or a metal object enters into the instrument, fire or electric shock may result. 

■ About the European WEEE Directive 

 

This instrument and its accessories are subject to the European WEEE Directive. 

Follow the applicable regulations of your country or region when discarding this instrument or its 

accessories. Follow the EU Battery Directive when discarding the batteries that you removed from 

this instrument. 

(WEEE stands for Waste Electrical and Electronic Equipment.) 

 

 

Follow the warnings and precautions that have been listed in this section to use the instrument 

correctly and safely. Precautions are also contained in various other sections of this instruction manual. 

To use the instrument correctly, be sure to follow those precautions as well. 
 
If you have any questions or comments about this instruction manual, please contact your local 

LEADER agent. 
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1. INTRODUCTION 

Thank you for purchasing this LEADER instrument. To use this instrument safely, read this 

instruction manual thoroughly, and make sure that you know how to use the instrument 

properly. 
 

If some point about the operation of this instrument is still unclear after you have read this 

instruction manual, refer to the contact information on the back cover of the manual to contact 

LEADER, or contact your local LEADER agent. 

After you have finished reading this manual, keep it in a convenient place so that you can refer 

to it when necessary. 
 

1.1 Scope of Warranty 

This LEADER instrument has been manufactured under the strictest quality control 

guidelines. 

LEADER shall not be obligated to furnish the following free services during the warranty 

period. 
 

1. Repair of malfunction or damages resulting from fire, natural calamity, or improper 

voltage applied by the user. 

2. Repair of an instrument that has been improperly repaired, adjusted, or modified by 

personnel other than a factory-trained LEADER representative. 

3. Repair of malfunctions or damages resulting from improper use. 

4. Repair of malfunctions caused by devices other than this instrument. 

5. Repair of malfunctions or damages without the presentation of a proof of purchase or 

receipt bill for the instrument. 
 

1.2 Operating Precautions 

1.2.1 Mechanical Shock 

This instrument contains sensitive components, so it may be damaged if it is dropped or 

otherwise exposed to a strong shock. 
 
1.2.2 Electrostatic Damage 

Electronic components can be damaged by static discharge. Static electricity can build up 

in the core wire of a coaxial cable. Before connecting a coaxial cable to the instrument, 

short the core wire of the cable with the external conductor. 
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1.2.3 Rack Mounting 

This instrument can be mounted on an EIA 19-inch rack. 
 

If you are mounting this instrument on a rack, be sure to provide additional support for the 

instrument. If you only use the flanges on the front panel to mount the instrument, the 

instrument case may be deformed, or the instrument may fall. 
 

Before mounting, remove the four feet from the bottom of the instrument. 

You can remove the feet by pressing the tab and pulling the feet out. 
 

 
 

1.3 Trademark Acknowledgments 

The company and product names in this document are trademarks or registered trademarks 

of their respective holders. 
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2. SPECIFICATIONS 

2.1 General 

This instrument is designed for use in evaluating the stereopsis effect at locations where 3D 

works are created or where products that use 3D are manufactured. This instrument can be 

used to evaluate items such as whether a video is easy to watch and whether the video is 

safe to be viewed by humans. 
 

2.2 Features 

● EIA 2U rack size 

A high-performance industrial PC with Windows 7 has been housed in a case that can be 

mounted in 2U rack space of an EIA 19-inch rack. 
 

● Support for various input formats 

The LT 7030A supports HD-SDI dual link and single link (Side by Side(Half) as well as Top 

and Bottom) as well as HDMI (Side by Side(Half), Top and Bottom, Line by Line, and 

Frame Packing) input signals, which enables it to measure a variety of 3D signals. 
 

● Automatic 3D disparity measurement (*1) 

• The video for the left eye and the video for the right eye that are applied to the SDI input 

connectors or the HDMI input connector are displayed in the upper left and upper right of 

the measurement screen. A depth image, which is a combination of the left and right 

video and which uses shading to indicate the depth of the disparity, is displayed in the 

middle of the screen. In place of the depth image, a convergence image, which indicates 

the difference between the left and right videos, or an overlay image can be displayed. 

• The LT 7030A performs a disparity analysis on the left and right video, and then displays 

a disparity histogram with the frequency of disparity occurrence on the vertical axis and 

the number of near points and the number of far points on the horizontal axis. The 

histogram is displayed in the bottom part of the measurement screen. 

• If the measured number of near points or the measured number of far points exceeds its 

set limit, the LT 7030A changes the color of the histogram bar to indicate this. At the 

same time, the display color of the depth image and the overlay image is changed to 

make it easy to see the locations where the limit has been exceeded. 

• The LT 7030A can display a disparity error log with time codes as references. 

• The LT 7030A can display a graph for observing how the maximum disparity changes 

over time. 

• The LT 7030A has two selectable log types: the error log, in which logs are recorded 

when errors occur, and the data log, in which all the measured frames are recorded. The 

maximum disparity with time codes as a reference, the histogram, a thumbnail, and other 

similar data is recorded to an XML file and can be displayed in a dedicated viewer. 

• The print feature of the error log viewer can be used to print data per frame or to print all 

the measured results. A disparity analysis report can also be printed. 

• The report feature of the analyzer can be applied to the data log to produce a report of 

how the maximum disparity changes. 

• The logs are recorded and stored in an internal SSD. The data can be transferred to 

USB memory devices. 
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● Disparity evaluation in hypothetical viewing environments 

Interpupillary distance, viewing distance, and screen width can be entered as instrument 

parameters, which makes it possible to evaluate the stereopsis effect that occurs in 

hypothetical viewing environments. 
 

● Monitoring of 3D video 

Connecting the HDMI output connector to a 3D TV makes it possible to monitor 3D video. 
 

● Running the OS in ROM Mode (*2) 

The system OS runs in ROM mode. Even if the power supply is suddenly cut off, it will not 

affect the system. 
 

*1 The automatic measurement display is shown with a time lag compared to the signal input. Also, if 

there are many flat parts in the video, if there are repetitions of similar patterns, if there are scenes that 

are extremely bright or dark, or in similar situations, incorrect depth information may be displayed. 

*2 The D drive is not handled as ROM. Data stored on this drive may be lost. 

 

2.3 Specifications 

2.3.1 I/O 

SDI Input (Rear Panel) 

Function Video signal input 

Input Connectors 2 BNC connectors 

Input Impedance 75 Ω 

HDMI Input (Rear Panel)(*1) 

Function Video signal input 

Input Connector One type A connector 

HDMI Output (Front Panel) 

Function Direct output of the input video signal 

Output Connector One type A connector 

USB Ports (Front and Rear Panels) 

Function For connecting a keyboard, mouse, and other 

USB devices 

Output Connectors 5 ports 

Monitor Connectors (Rear Panel) 

Function Measurement screen output 

Display Format XGA or higher (1920 × 1080 recommended) 

Output Connectors DVI-D, VGA (D-sub), and HDMI (one connector 

each) 

VGA Locking screws Inch screws (No.4-40UNC) 
 

*1 You cannot apply content protected signals to the HDMI input connector. 
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2.3.2 Automatic 3D Disparity Measurement 

Function Automatic measurement of the disparity of the 

video in the applied SDI or HDMI signal 

Signal Input 

Connector SDI or HDMI 

SDI 

Single Link BNC input connector, SDI input connector 

3D Format Side by Side(Half), Top and Bottom 

Dual Link 

Left Video BNC input connector, SDI input connector 

Right Video BNC input connector, SDI input connector 

HDMI HDMI input connector 

3D Format Side by Side(Half), Top and Bottom, Line by 

Line, Frame Packing 

Video Format 

SDI 1080p/23.98, 1080p/24, 1080p/25, 

1080p/29.97, 1080p/30, 1080PsF/23.98, 

1080PsF/24, 1080PsF/25, 1080PsF/29.97, 

1080PsF/30, 1080i/50, 1080i/59.94, 1080i/60 

HDMI 1080p/23.98, 1080p/24, 1080p/25, 

1080p/29.97, 1080p/30, 1080i/50, 1080i/59.94, 

1080i/60 

Signal Output (Monitor) 

Connector HDMI output connector (InfoFrame is 

supported) 

3D Format 

With SDI Input Side by Side(Half) 

With HDMI Input The input 3D format 

Video Format 

SDI Input 

With 1080p, 1080i Input The input video format 

With 1080PsF/23.98 Input 1080p/23.98 

With 1080PsF/24 Input 1080p/24 

With 1080PsF/25 Input 1080i/50 

With 1080PsF/29.97 Input 1080i/59.94 

With 1080PsF/30 Input 1080i/60 

With HDMI Input The input video format 

Display 

Preview Display Left and right input video 

Displayed in the upper left and upper right of 

the measurement screen, respectively. 

Combined Video Display Depth, convergence, overlay 

Displayed in the top center of the measurement 

screen 
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Histogram Display Disparity distribution display 

Displayed in the bottom of the measurement 

screen 

Polarity 

+ Far 

- Near 

Display Scale 

Vertical Axis Scale Auto range, manual range 

Number of Occurrences (Manual Range) 

2,000, 6,000, 15,000, 30,000, 60,000, FULL 

(129,600) 

Threshold Line 0 to 100 % 

Horizontal Axis Scale 

Measurement of All Areas 20 %, 10 %, 3.3 % 

Measurement of Selected Area 5 %, 2.5 % 

Display Unit 

Screen Disparity %, cm, dot 

Perceived Depth cm 

Angle of Vergence ° 

Angular Disparity ° 

Time Code Format RP188, VITC, Serial, PC Local Time 

Error Log 

Display Position Displayed transparently on the left side of the 

histogram 

Items Time code, frame count, near OK/NG, 

maximum near value, far OK/NG, maximum far 

value 

Time Graph 

Display Position Below the histogram 

Item Maximum disparity changes 

Graph Direction Left to right, right to left 

Parameters (Viewing Conditions) 

Interpupillary Distance 2.00 to 20.00 cm 

Viewing Distance 1.00 cm or more 

Screen Width 6.00 to 25,000.00 cm 

Measurement Cycles (*1) 2 cycles per second or more 

Measurement Delay 1 second or less 

Measurement Range (*2) 

Far 

Measurement of All Areas 

With 20 % Scale 0 to 20 % (0 to 384 dots) 

With 10 % Scale 0 to 10 % (0 to 192 dots) 

With 3.3 % Scale 0 to 3.33 % (0 to 64 dots) 

Measurement of Selected Area 

With 5 % Scale 0 to 5 % (0 to 96 dots) 

With 2.5 % Scale 0 to 2.5 % (0 to 48 dots) 
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Near 

Measurement of All Areas 

With 20 % Scale -20 to 0 % (-384 to 0 dots) 

With 10 % Scale -10 to 0 % (-192 to 0 dots) 

With 3.3 % Scale -3.33 to 0 % (-64 to 0 dots) 

Measurement of Selected Area 

With 5 % Scale -5 to 0 % (-96 to 0 dots) 

With 2.5 % Scale -2.5 to 0 % (-48 to 0 dots) 

Resolution of Measured Disparity (*2) 

Measurement of All Areas 0.21 % (4 dots) 

Measurement of Selected Area 0.05 % (1 dot) 

Settable Range of the Disparity Upper Limit 

Same as the measurement range 
 

*1 If thumbnails are being acquired to the error log, this may be smaller than the specified value. 

*2 The screen disparity (cm), perceived depth, angle of vergence, and angular disparity vary depending 

on how the parameters are configured. The LT 7030A does not measure disparities that exceed the 

scale. 

 
2.3.3 Log Viewer 

Logs Error log, data log 

File Format XML 

Display 

Items Time code, frame count, near OK/NG, 

maximum near value, far OK/NG, maximum far 

value 

Histogram Display Disparity distribution display 

Threshold Line for the Number of Occurrences 

0 to 100 % (manual) 

Display Unit 

Screen Disparity %, cm, dot 

Perceived Depth cm 

Angle of Vergence ° 

Angular Disparity ° 

Printing 

Items Version information, parameters, upper limit, 

time code, disparity, vertical range, horizontal 

range, threshold, histogram, thumbnail, signal 

input connector, video format 

Format Disparity analysis report per frame, disparity 

analysis report per 1800 frames, all disparity 

analysis reports (contains aggregate results) 
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Export 

Format CSV 

Items Parameters, upper limit, time code, disparity, 

vertical range, horizontal range, threshold, 

histogram data, signal input connector, video 

format 

Analyze Feature Only for the data log 

Time Graph Maximum disparity changes, magnified display 

Data Analysis Statistical processing of all acquired data 

Report Printing of analysis reports for maximum 

disparity changes (contains aggregate results) 
 
2.3.4 System 

Operating System Windows 7 Professional 32 bit English Version 

CPU Intel Core 2 Duo processor 2.26 GHz 

System Memory 8 GB 

Storage Device (*1) 

CF, OS Areas 4 GB 

SSD, Data Areas 40 GB 

Keyboard English USB keyboard (included) 

Mouse USB wheel mouse (included) 
 

*1 Specifications subject to change without prior notice due to product improvements. 

 
2.3.5 General Specifications 

Environmental Conditions 

Operating Temperature Range 0 to 40 °C 

Operating Humidity Range 85 %RH or less (no condensation) 

Operating Environment Indoors 

Elevation Up to 2,000 m 

Overvoltage Category II 

Pollution Degree 2 

Power Requirements 

Voltage 90 to 250 VAC 

Frequency 50/60 Hz 

Power Consumption 85 W max. 

Dimensions 482 (W) × 88 (H) × 250 (D) mm 

(excluding protrusions) 

Weight 5.8 kg (excluding accessories) 

Accessories CD-ROM (Software, instruction manual) ....... 1 

Power cord .................................................... 1 

Keyboard....................................................... 1 

Mouse ........................................................... 1 
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2.4 Principles of Automatic 3D Disparity Measurement 

This section explains the automatic 3D disparity measurement principles. 
 
2.4.1 Measurement Method 

During automatic 3D disparity measurement, the LT 7030A automatically measures the 

horizontal disparity within the video. The measurement method is explained below. 

Note that in the following explanation, the Area Mode menu item has been set to Normal. 
 

1. The video for the left eye and the video for the right eye are both reduced to 480 dots × 
270 lines. 

Video for the left eye 

 
 

Video for the right eye 
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* When the 3D format is set to Side by Side(Half), the video for the left eye and the video for the 

right eye are both expanded from 960 dots × 1080 lines to 1920 dots × 1080 lines before being 

reduced to 480 dots × 270 lines. 

* When the 3D format is set to Top and Bottom, the video for the left eye and the video for the 

right eye are both expanded from 1920 dots × 540 lines to 1920 dots × 1080 lines before being 

reduced to 480 dots × 270 lines. 

 

2. The edges are extracted from the reduced video. 

Video for the left eye (480 dots × 270 lines) 

 
 

Video for the right eye (480 dots × 270 lines) 

 
 

3. On the same line, the LT 7030A finds the edge of the video for the right eye that 

corresponds to the edge of the video for the left eye and measures the horizontal 
disparity between the edges. 

This process is carried out for all 270 lines. The LT 7030A counts the number of 

occurrences of horizontal disparity and shows them on a histogram. 

The horizontal disparity measurement resolution is 1920 dots/480 dots = 4 dots 

(approximately 0.21 %). 
 

Figure showing the overlapping of the video for the left eye and the video for the right eye 
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2.4.2 Measurement Range 

You can set the horizontal disparity measurement range by setting Horizontal Range on the 

Range menu to 20% Histogram, 10% Histogram, or 3.3% Histogram. (When the Area 

Mode menu item is set to Select, the options you can select are 5% Histogram and 2.5% 

Histogram.) 
 

● 20% Histogram 

The LT 7030A searches within the range of ±20 % (±96 dots: ±384 dots when converted 

to the video prior to reduction) of the edges of the reduced video for the left eye to find 

the corresponding edges of the reduced video for the right eye. 
 

 
 

● 10% Histogram 

The LT 7030A searches within the range of ±10 % (±48 dots: ±192 dots when converted 

to the video prior to reduction) of the edges of the reduced video for the left eye to find 

the corresponding edges of the reduced video for the right eye. 
 

 
 

● 3.3% Histogram 

The LT 7030A searches within the range of ±3.33 % (±16 dots: ±64 dots when converted 

to the video prior to reduction) of the edges of the reduced video for the left eye to find 

the corresponding edges of the reduced video for the right eye. 
 

 
 

The default measurement range setting is 20% Histogram. However, by switching the 

setting to 10% Histogram when you have confirmed that the disparity will not exceed ±10 % 

in the video being measured or 3.3% Histogram when you have confirmed that the 

disparity will not exceed ±3.33 %, you can perform highly precise measurements. 
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2.4.3 Video That Can Easily Produce Measurement Errors 

Because of the limitations of the horizontal disparity measurement principles, the following 

types of video can easily produce measurement errors. 
 

Video That Can Easily Produce 

Measurement Errors 

Video Example Notes 

Flat video The LT 7030A cannot measure the 

disparity of flat parts (it can 

measure outlines). 

Video in which the outline is not 

clear 

(video that is out of focus). 

Video that is too bright overall so 

the outline is not clear 

(video in which the iris setting is 

incorrect). 

Video that is too dark overall so 

the outline is not clear 

(video in which the iris setting is 

incorrect). 

Video that is too bright and in 

which lens flare has occurred. 

It is easy for measurement errors 

to occur because it is difficult for 

the LT 7030A to extract the edges.

Video that has repeating vertical 

lines. 

It is easy for measurement errors 

to occur because it is difficult for 

the LT 7030A to find the edges of 

the video for the right eye that 

correspond to the edges of the 

video for the left eye. 
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3. PANEL DESCRIPTION 

3.1 Front Panel 

 
 

1 Power LED (green) 

Lights when the power is on. 
 

2 Power switch 

The LT 7030A turns on automatically when an AC power source is supplied. Press this 

switch when you need to turn the power on after turning it off. 
 

3 Access LED (red) 

This LED lights when the internal CF or SSD is being accessed. When this LED is lit, do 

not remove the power plug. 
 

4 Vent 

This is a vent for cooling the LT 7030A. If AC power is being fed to the LT 7030A but the 

power is turned off, you will see a red light inside the case. This is not a malfunction. 
 

5 USB port 

Connect the accessory keyboard or mouse to this port. You can also connect USB 

devices such as USB memory devices. 
 

6 HDMI OUTPUT 

This is the 3D video monitor output connector. By connecting this to a 3D TV, you can 

view the input 3D video. 
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3.2 Rear Panel 

 
 

1 HDMI INPUT 

This is the HDMI signal input connector. 
 

2 Connector Cover 

This is not used on the LT 7030A. Do not remove the connector cover. 
 

3 Display connector (HDMI) 

4 Display connector (VGA) 

5 Display connector (DVI-D) 

These are the measurement screen output connectors. Connect a display (XGA or 

higher, FHD is recommended) to one of these connectors. 
 

6 USB ports 

Connect the included keyboard and mouse to these ports. You can also connect USB 

devices such as USB memory devices. 
 

7 SDI INPUT 

These are the SDI signal input connectors. Connect the video for the left eye to the L 

connector and the video for the right eye to the R connector. In single link mode, connect 

the video to the L connector. 
 

8 Serial number name plate 

The instrument's serial number is written on this name plate. 
 

9 Protective ground connector 

Connector for connecting to external ground. 
 

10 AC inlet 
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4. BEFORE YOU BEGIN MEASURING 

4.1 ROM Mode 

The hardware configuration of this instrument is based on an industrial computer. The 

instrument is composed of an Intel chipset Mini-ITX motherboard with a dual-core CPU (Core 

2 Duo) and Microsoft Windows 7 Professional as its operating system. During normal 

operation, this system is no different than an ordinary consumer PC, but there are some 

differences because the system has been designed specifically for measurement 

applications. 
 

This instrument employs a solid-state drive called CF as its main storage device. The CF is 

superior to typical hard disk drives in service life and stability. However, the CF has limitations 

in the number of times data can be written to it and is also vulnerable to data corruption when 

power is interrupted unexpectedly. Therefore, the system area containing the OS and 

applications must be handled as a ROM. 
 

This instrument uses a software tool called Stick Lite 7 by ROM-Win to make the system area 

read-only. This tool reserves a section of memory as an emulation area. When there is a 

request to write data to the CF, the data is written in the emulation area in order to keep the 

Windows system and application area read-only. This prolongs the service life of the CF and 

prevents data corruption caused by a sudden power interruption. 
 
4.1.1 Notes 

Below are notes about this instrument running in ROM mode. 
 

• Even if you install a software application, when you restart the system, the system will 

return to the condition it was in before the application was installed. 

• Even if you change the Windows configuration, when you restart the system, the system 

will return to the original configuration. 

• Drivers that are not installed by factory default will be installed through Plug and Play 

every time you start the system. 

• Even if system files are corrupted due to operation errors or unexpected accidents, you 

can restore the system by restarting it. 

• The D drive is not handled as ROM. The data stored on this drive will not be deleted 

when you restart the system. 
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4.1.2 Releasing the ROM Mode 

You can release the ROM mode so that the system retains the changes that you make to 

the Windows configuration, such as the configuration for connecting to the in-company 

network, user account settings, and desktop configuration, and external device drivers that 

needs to be used regularly. 

To release the ROM mode, follow the procedure below. 
 

1. Double-click "C:\Program Files\RWFLASH\rwflash." 

2. When the following window appears, click Immediately or After restart. 

If you select Immediately, the ROM mode is released immediately. 

If you select After restart, the ROM mode is released when you restart the system. In 

the "Release times" box, enter the number of times the system will need to be 

restarted before the ROM mode is enabled again. 
 

 
 

3. When the following window appears, click Yes. 

When you select Immediately When you select After restart 

  
 

4. Make the necessary configuration changes while the ROM mode is disabled. 

When you select Immediately 

The ROM mode is released immediately after you click Yes in step 3. Make the 

necessary changes, and restart the system. The system will restart in ROM mode. 
 

When you select After restart 

Restart the system. The ROM mode is released immediately after you restart. Make 

the necessary changes, and restart the system again. When you restart the system 

the number of times specified by Release times, the ROM mode will be enabled. 
 

For example, if you set Release times to 2, the ROM mode will be enabled the second 

time you restart the system after the ROM mode is disabled. 
 

ROM mode

(current) 

Restart ROM mode

released 

Restart ROM mode

released 

Restart ROM mode 



4. BEFORE YOU BEGIN MEASURING 

17 

Notes 

Installing third party software applications (including antivirus software) not specified 

by LEADER will void the guarantee. 
 

The following settings affect the operation of this instrument. Do not change them. 
 

Setting Value 

Turn off the display Never Power Options 

Put the computer to sleep Never 

 

4.2 User Account 

The Windows user account that is configured in the factory default settings is shown below. 

When you log on to the LT 7030A or recover it from sleep mode, enter the user name and 

password shown here. 
 

User name: lt7030a 

Password: lt7030a 
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4.3 Connection 

● Input Signal 

Apply the video for the left eye (L) and the video for the right eye (R) to the SDI input 

connectors or to the HDMI input connector. BNC and HDMI cables are not included with the 

LT 7030A. 
 

● Display 

Connect a display (XGA or higher, FHD is recommended) to the HDMI output connector, VGA 

output connector, or DVI-D output connector. The display and the connecting cables are not 

included with the LT 7030A. 

This instrument was verified to work properly when an FHD display was connected to the 

DVI-D output connector. 
 

● Mouse, Keyboard, and Optional USB Devices 

Connect the included mouse and keyboard to the USB ports (you can also connect a mouse 

and keyboard that you have purchased separately). 

You can also use USB devices (USB 2.0 devices are recommended) such as USB memory 

devices. Connect these other devices as necessary. 
 

● 3D TV (Optional) 

By connecting a 3D TV to the HDMI output connector, you can view the 3D video on a TV. 
 

 
 

* The mouse and keyboard shown here are just examples. They are different from the actual accessories 

that are included. 
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4.4 Turning the Instrument On and Off 

● Turning the Instrument On 

The LT 7030A turns on automatically when an AC power source is supplied. The automatic 

3D measurement software starts when the LT 7030A turns on. (If the LT 7030A does not turn 

on when an AC power source is supplied, you can use the front panel power switch to turn 

the LT 7030A on.) 
 

The LT 7030A starts with the settings that were last exported through the use of the Export 

command on the File menu. If there is no exported file, an error message will be displayed, so 

click OK. In this situation, the LT 7030A will start with the default settings. 

See section 5.4.1, “File.” 

 

● Turning the Instrument Off 

To turn off the instrument, stop disparity measurement, turn off Data Logging and Graph and 

Error Logging, and then shut down Windows. To shut down windows, on the task bar, click 

Start and then Shut down. 
 

4.5 About the Names of Settings and Measurement Items 

The names of the settings and measurement items that are used with the LT 7030A are 

shown below. 

When a 3D image appears recessed on the screen, it is said to be “Far.” When a 3D 

image appears to jump out of the screen, it is said to be “Near.” 
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5. AUTOMATIC 3D DISPARITY MEASUREMENT 

5.1 Window Explanation 

 
 

1 Menu 

Performs file operations and configures various settings. 

See section 5.4.1, “File.” 
 

2 Area Select 

Appears when the Area Mode menu item is set to Select. You can measure the disparity 

of the selected 480 dots × 270 lines area of the 1920 dots × 1080 lines video. 

See section 5.4.8, “Area Mode.” 
 

3 3D Video 

From the left, the video for the left eye, the combined video, and the video for the right 

eye are displayed. 

For the combined video, you can select from the following display modes: depth, 

convergence, and overlay. 

See section 5.4.7, “Option.” 
 

4 Data Logging and Graph 

Select whether to record the data log. If you turn this on, you can also view a time graph 

with time on the horizontal axis and the maximum disparity on the vertical axis. 

You can use the F1 key or Data Logging and Graph on the Option menu to perform the 

same function. However, after you click the Data Logging and Graph button, you will not 

be able to use the F1 key until you restart the automatic 3D disparity measurement 

software. 
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You cannot turn both the Data Logging and Graph button and the Error Logging button 

on at the same time. 

See section 5.4.7, “Option.” 
 

 (Gray): The data log will not be recorded. This is the 

default setting. 

 (Yellow): The data log will be recorded. 

 (Green): The LT 7030A will start recording the data log at 

the specified time. 

 (Green): The LT 7030A will stop recording the data log at 

the specified time. 
 

5 Error Logging 

Select whether to log disparity errors. 

You can use Error Logging on the Option menu to perform the same function. 

You cannot turn both the Error Logging button and the Data Logging and Graph button 

on at the same time. 

See section 5.4.7, “Option.” 
 

 (Gray): Error will not be logged. This is the default 

setting. 

 (Yellow): Errors will be logged. 

 (Green): The LT 7030A will start logging errors at the 

specified time. 

 (Green): The LT 7030A will stop logging errors at the 

specified time. 
 

6 Thumbnail 

Select whether to record the combined video when logs are recorded. 

You can use Thumbnail on the Option menu to perform the same function. 

See section 5.4.7, “Option.” 
 

 (Gray): The combined video will not be recorded. This 

is the default setting. 

 (Yellow): The combined video will be recorded. 
 

7 Start or Running 

Starts acquiring the 3D video and starts the disparity measurement. The 3D video is also 

generated from the front panel HDMI OUTPUT connector. 

You can use the SPACE key or Start on the Process menu to perform the same function. 

However, after you click the Start button, you will not be able to use the SPACE key until 

you restart the automatic 3D disparity measurement software. 

See section 5.4.6, “Process.” 
 

 (Gray): Disparity is not being measured. This is the 

default setting. 

 (Yellow): Disparity is being measured. 
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8 Stop 

Stops the disparity measurement. 

You can use the SPACE key or Stop on the Process menu to perform the same function. 

However, after you click the Stop button, you will not be able to use the SPACE key until 

you restart the automatic 3D disparity measurement software. 

See section 5.4.6, “Process.” 
 

 (Gray): Disparity is not being measured. 

 (Gray): Disparity is being measured. 
 

9 Capture 

Takes a screen capture of the 3D video. 

You can use Capture on the Process menu to perform the same function. 

See section 5.4.6, “Process.” 
 

10 Detailed Analysis 

After you take a screen capture, click this to analyze the screen capture data. 

See section 5.4.6, “Process.” 
 

11 Histogram Display 

A histogram is displayed with the near and far distances from the screen on the 

horizontal axis and the number of occurrences on the vertical axis. The maximum 

disparities are displayed as values above the histogram. 

See section 5.2, “Histogram Explanation.” 
 

12 Time Graph Display 

When Data Logging and Graph is on, a time graph is displayed with time on its horizontal 

axis and maximum disparity on its vertical axis. 

See section 5.4.7, “Option.” 
 

13 Status Display 

Displays the settings and the input signal information. 
 

Item Explanation 

INPUT Displays the input connector and format that have been selected on the Input 

menu. 

See section 5.4.2, “Input.” 

IPD 

Viewing Distance 

Screen Width 

Displays the viewing environment that has been configured on the Parameter 

screen. 

See section 5.4.3, “Parameter.” 

Horizontal Displays the number of horizontal dots. This is fixed to 1920.00 dots. 

Limit Near 

Limit Far 

Displays the upper disparity limits that have been set on the Upper Limit menu.

See section 5.4.4, “Upper Limit.” 

Time Code Displays the time code embedded in the input signal. Set Time Code Source on 

the Option menu to select the time code format. 

See section 5.4.7, “Option.” 

Frame Count Displays the frame count embedded in the input signal. 

Status Displays the current measurement status. 

Stop: Disparity is not being measured. Running: Disparity is being measured. 
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Item Explanation 

See section 5.4.6, “Process.” 

Data Logging and 

Graph 

Displays whether to log data. 

OFF: Data will not be logged. ON: Data will be logged. 

See section 5.4.7, “Option.” 

Error Logging Displays whether to log errors. 

OFF: Errors will not be logged. ON: Errors will be logged. 

See section 5.4.7, “Option.” 

Thumbnail Displays whether the combined video will be recorded when logs are recorded.

OFF: The combined video will not be recorded. ON: The combined video will be 

recorded. 

See section 5.4.7, “Option.” 

Synthesize Effect Displays the display mode of the combined video that you selected by setting 

Synthesize Effect on the Option menu. 

See section 5.4.7, “Option.” 

Horizontal Range 

Vertical Range 

Displays the range that has been selected on the Range menu. 

See section 5.4.5, “Range.” 

Limit Expression Displays the upper limit display format that you selected by setting Limit 

Expression on the Option menu. 

See section 5.4.7, “Option.” 

Including 0% Bar 

Excluding 0% Bar 

Displays whether the LT 7030A will measure 0 % disparity (no disparity), which 

you have selected on the Option menu. 

Including 0% Bar: 0 % disparity will be measured. Excluding 0% Bar: 0 % 

disparity will not be measured. 

See section 5.4.7, “Option.” 

Histogram Displays the histogram color that you selected on the Histogram menu. 

Normal: Normal display. Color Map: Gradation display. 

See section 5.4.7, “Histogram.” 

Area Mode Displays the measurement area that you have selected on the Area Mode 

menu. 

Normal: Measurement of all areas. Select: Measurement of selected area. 

See section 5.4.8, “Area Mode.” 

TimeCode Displays the time code mode that is used when logs are recorded, which you 

have selected by setting Time Code Mode on the Option menu. 

Normal: Normal time codes. Zero Start: The recording start time is 00:00:00. 

See section 5.4.9, “Option.” 
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5.2 Histogram Explanation 

The LT 7030A considers disparities that are less than Near Limit or greater than Far Limit as 

errors. However, even in these situations, as long as the number of disparity occurrences is 

less than or equal to Threshold, the LT 7030A does not consider the disparities as errors. 
 

 
 

* For the sake of the explanation, we have simplified the figure. 

 

You can set Near Limit, Far Limit, and Threshold to any values that you want on the Upper 

Limit menu. Threshold is a percentage with Vertical Range set on the Range menu assumed 

to be 100 %. 

See sections 5.4.4, “Upper Limit,” and 5.4.5, “Range.” 

 

An explanation of the colors used in the histogram is given below. 

The cells in the table that are shaded in indicate the ranges that the LT 7030A considers as 

disparity errors. 
 

Near and Far Distances from the Screen  

Less than 

Near Limit 

Between Near Limit

and Far Limit 

Greater than 

Far Limit 

Range Over(*1)  Orange (*2)  Purple  Green (*2) 

Greater than Threshold  Red (*2)  Light blue  Blue-green (*2)

Number of 

Occurrences 

Less than or Equal 

to Threshold 

 Pink  Pink  Pink 

 
*1 This does not occur when Vertical Range is set to Auto. The disparity that occurs the most is set to 

100 %. 

*2 When the Histogram menu item is set to Color Map, +7.5 % is displayed in blue, -7.5% is displayed in 

red, and the values between these end points are displayed with a gradation. (When the Area Mode 

menu item is set to Select, the values between +1.87 % and -1.87 % are displayed with a gradation.) 
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5.3 How to Use 

This section explains the basic operating procedures of the LT 7030A. 
 

1. Connect the necessary devices to the LT 7030A, and then turn on the LT 7030A. 

See sections 4.1, “Connection,” and section 4.4, “Turning the Instrument On and Off.” 
 

2. On the Input menu, select the input connector, link format, 3D format, and video format 
from the values shown below. 

See section 5.4.2, “Input.” 
 

Input Connector Link Format 3D Format Video Format 

Dual Link - 

Side by Side(Half)

SDI 

Single Link 

Top and Bottom 

1080i 59.94, 1080i 60, 1080p 23.98, 

1080psf 23.98, 1080p 24, 1080psf 24,

1080p 29.97, 1080psf 29.97, 

1080p 30, 1080psf 30, 1080i 50, 

1080p 25, 1080psf 25 

Side by Side(Half)

Top and Bottom 

Line by Line 

HDMI - 

Frame Packing 

1080i 59.94, 1080i 60, 1080p 23.98, 

1080p 24, 1080p 29.97, 1080p 30, 

1080i 50, 1080p 25 

 
3. On the Parameter menu, configure the viewing environment. 

After you have finished configuring the settings, click OK. 

See section 5.4.3, “Parameter.” 
 

 
 

4. Use Near Limit and Far Limit on the Upper Limit menu to set the upper disparity limits. 

If the measured disparity exceeds one of these upper limits, an error will occur. 

After you have finished configuring the settings, click OK. 

See section 5.4.4, “Upper Limit.” 
 

Near Limit Far Limit 
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5. Use Error Threshold on the Upper Limit menu to set the disparity occurrence threshold. 

Even if disparity errors occur, if the number of occurrences is less than or equal to the 

threshold that you set here, the LT 7030A will not consider the disparities as errors. After 

you have finished configuring the settings, click OK. 

See section 5.4.4, “Upper Limit.” 
 

 
 

6. If you want to record logs during measurement, configure the corresponding setting on the 
Option menu. 

Turning Logging On and Off 

The LT 7030A has two log types: the data log, in which all the measured frames are 

recorded, and the error log, in which logs are recorded only when disparity errors occur. 
 

To turn on data logging, click Data Logging and Graph on the Option menu. Data 

Logging and Graph will be displayed in orange. Alternatively, click the Data Logging and 

Graph button in the middle of the screen, or press F1. In both cases, Data Logging and 

Graph will be displayed in yellow. In this situation, you can view a time graph with time on 

the horizontal axis and the maximum disparity on the vertical axis. 
 

To turn on error logging, click Error Logging on the Option menu. Error Logging will be 

displayed in orange. Alternatively, click the Error Logging button in the middle of the 

screen. Error Logging will be displayed in yellow. 
 

You can also turn logging on and off during measurements. 
 

Turning Thumbnails On and Off 

You can record the combined video together with logs. 

To turn on combined video recording, click Thumbnail on the Option menu. Thumbnail 

will be displayed in orange. Alternatively, click the Thumbnail button in the middle of the 

screen. Thumbnail will be displayed in yellow. 

You can also turn combined video recording on and off during measurements. 
 

Selecting the Time Code Format 

In the logs, data is recorded with time codes as references. Use Time Code Source on 

the Option menu to select the time code format from the values shown below. 

RP188, VITC, Serial, PC LocalTime 
 

By setting Time Code Mode to Zero Start on the Option menu, you can set the logging 

start time to 00:00:00. 
 

See section 5.4.7, “Option.” 
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7. Click the Start button in the center of the screen or press SPACE. 

The LT 7030A starts acquiring the 3D video and starts the disparity measurement. The 

3D video is also generated from the front panel HDMI OUTPUT connector. To stop the 

measurement, click the Stop button in the center of the screen, or press SPACE. 

See section 5.4.6, “Process.” 
 

If you turned logging on in step 6, the LT 7030A automatically saves log data. To view the 

saved log data, use the log viewer. 

See chapter 6, “LOG VIEWER.” 
 

 
 

5.4 Menu Explanation 

5.4.1 File 

The structure of the File menu is shown below. During disparity measurements, you cannot 

select the File menu. 
 

Select the Folder for Log

Log Viewer

File Import

Close

SettingsExport
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● Import 

Imports the 3dms-format (a proprietary LEADER format) setup data that you exported with 

the Export menu item. 

When Error Logging or Data Logging and Graph is on, you cannot import data. 
 

Sample data is saved in the following file: “D:\LT7030A\Sample\sample.3dms.” This data 

has the settings that are necessary to perform measurements, so you can use this data to 

immediately perform basic operations. 
 

 
 

● Export - Settings 

Exports settings in 3dms format (a proprietary LEADER format) or csv format. Use the 

“Save as type” list to select the file format. 

You can use the Import menu item to import data that you export in 3dms format. 

You can use Microsoft Excel or a similar program to view data that you export in csv format. 
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● Log Viewer 

Displays the logs that have been recorded during disparity measurement. When Error 

Logging or Data Logging and Graph is on, you cannot view the logs. 

See chapter 6, “LOG VIEWER.” 

 

● Select the Folder for Log 

Select the save location for the recorded logs. 

In the factory default settings, this is set to “D:\LT7030A.” 
 

 
 

● Close 

Stops the automatic 3D disparity measurement. You can also use the close button in the 

upper right of the screen to stop the measurement. 

To restart the software, double-click the “3D Assist Box” icon on the desktop. 
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5.4.2 Input 

The structure of the Input menu is shown below. During disparity measurements, you 

cannot select the Input menu. 
 

・

・

Single Link Side by Side(Half)

Top and Bottom

・

Dual Link

HDMI

1080psf 25

Line by Line

Frame Packing

SDI

1080i 60

Side by Side(Half)

Top and Bottom

1080i 59.94

Input

Video Format

1080p 25

 
 

● SDI and HDMI 

Use these menu items to select the input connector, link format, and 3D format from the 

values shown below. 
 

Input Connector Link Format 3D Format 

Dual Link - 

Side by Side(Half) 

SDI 

Single Link 

Top and Bottom 

Side by Side(Half) 

Top and Bottom 

Line by Line 

HDMI - 

Frame Packing 

 

● Video Format 

Select the input format. The formats that you can select vary depending on the input 

connector as shown in the following table. 
 

Input Connector Input Format 

SDI 1080i 59.94, 1080i 60, 1080p 23.98, 1080psf 23.98, 1080p 24, 

1080psf 24, 1080p 29.97, 1080psf 29.97, 1080p 30, 1080psf 30, 

1080i 50, 1080p 25, 1080psf 25 

HDMI 1080i 59.94, 1080i 60, 1080p 23.98, 1080p 24, 1080p 29.97, 1080p 30, 

1080i 50, 1080p 25 
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5.4.3 Parameter 

Click Parameter to display the Parameter screen. Use this screen to configure the viewing 

environment. 

During disparity measurements, you cannot configure the Parameter settings. 
 

 
 

Item Explanation 

IPD Enter the interpupillary distance (2.00 to 20.00 cm). 

For adults, this is 6.50 cm. For children, this is approximately 5.00 cm. 

Viewing Distance Enter the distance from the screen to the viewer (1.00 cm or more). 

Screen Width Enter the screen width (6.00 to 25000.00 cm). 

 
5.4.4 Upper Limit 

The structure of the Upper Limit menu is shown below. 

During disparity measurements, you cannot select the Upper Limit menu. 
 

Near Limit for Area Select

Far Limit for Area Select

Upper Limit Near Limit

Far Limit

Error Threshold

Remove Limit

 
 

● Near Limit, Near Limit for Area Select, Far Limit, and Far Limit for Area Select 

Use these menu items to enter the upper disparity limits. If the measured disparity exceeds 
one of these upper limits, an error will occur. 
You can set the values separately when the Area Mode menu item is set to Normal and 

when it is set to Select. 

When Error Logging or Data Logging and Graph is on, you cannot set the upper limits. 
 

When you enter one of the Screen Disparity settings, the other settings are set 

automatically. However, when the Parameter items are not set, you cannot enter any 

settings other than Screen Disparity (% or dot). 
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Near Limit (for Area Select) Far Limit (for Area Select) 

  
 

Item Explanation 

Screen Disparity Enter the upper limit for the screen disparity. 

Enter negative values for the Near disparity (-100.00 to 100.00 %). 

Perceived Depth Enter the near and far limits as distances from the screen. 

Enter negative values for the Near disparity. 

Angle of Vergence Enter the upper limit for the angle of vergence. 

Angular Disparity Enter the upper limit for the angular disparity. 

 

● Remove Limit 

Clears the Near Limit and Far Limit settings. 
 

● Error Threshold 

Enter the disparity error occurrence threshold. Even if disparity errors occur, if the number 

of occurrences is less than or equal to the threshold that you set here, the LT 7030A will not 

consider the disparities as errors (0 to 100 %). 
 

Set the threshold as a percentage with Vertical Range set on the Range menu assumed to 

be 100 %. When Vertical Range is set to Auto, 100 % represents the disparity that occurs 

the most. 

See section 5.4.5, “Range.” 
 

 
 

Threshold Setting Method (Recommended) 

a) On the Range menu, set Vertical Range to Full(129600). On the Option menu, set 

Synthesize Effect to Depth. 
 

b) Apply the 3D video signal. 
 

c) Set the threshold so that there is a clear definition between the light and dark parts of 

the combined video and so that there is little noise in the combined video. As a 

guideline, the threshold should be set to a value between 1 and 4 % at this step. 
 

d) Adjust the threshold while you reduce the Vertical Range setting on the Range menu. 

As a guideline, the final Vertical Range setting should be around 15000. 
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5.4.5 Range 

The structure of the Range menu is shown below. 
 

3.3% Histogram

5%   Histogram

10% Histogram

15000

Full(129600)

6000

Range

2.5% Histogram

Vertical Range

60000

30000

Auto

2000

Horizontal Range 20% Histogram

 
 

● Horizontal Range 

Select the disparity measurement range (the histogram's horizontal axis) from the values 

shown below. 

During disparity measurements, you cannot select this menu item. 

See section 2.4.2, “Measurement Range.” 
 

When the Area Mode Menu Item Is Set to Normal 

20% Histogram, 10% Histogram, 3.3% Histogram 
 

When the Area Mode Menu Item Is Set to Select 

5% Histogram, 2.5% Histogram 
 

● Vertical Range 

Select the measurement range of the number of occurrences (the histogram's vertical axis) 

from the values shown below. 

When you select Auto, 100 % represents the disparity that occurs the most. 
 

Auto, 2000, 6000, 15000, 30000, 60000, Full(129600) 



5. AUTOMATIC 3D DISPARITY MEASUREMENT 

34 

5.4.6 Process 

The structure of the Process menu is shown below. 
 

Capture

Stop

Process Start

 
 

● Start 

The LT 7030A starts acquiring the 3D video and starts the disparity measurement. You can 

also use the Start button in the center of the screen or the SPACE key to start the 

acquisition and measurement. 

During disparity measurements, you cannot select this menu item. 
 

The 3D video is also generated from the front panel HDMI OUTPUT connector. The format 

of the output signal varies depending on the input signal as shown in the following table. 
 

Input Signal Output Signal 

Input 

Connector 

Format Video Format Format Video Format 

1080i, 1080p (*1) Side by Side(Half) The same as the input signal

1080psf 23.98 Side by Side(Half) 1080p 23.98 

1080psf 24 Side by Side(Half) 1080p 24 

1080psf 29.97 Side by Side(Half) 1080i 59.94 

1080psf 30 Side by Side(Half) 1080i 60 

SDI Single Link or 

Dual Link 

1080psf 25 Side by Side(Half) 1080i 50 

Side by Side(Half) 1080i, 1080p (*1) Side by Side(Half) The same as the input signal

Top and Bottom 1080i, 1080p (*1) Top and Bottom The same as the input signal

Line by Line 1080i, 1080p (*1) Line by Line The same as the input signal

HDMI 

Frame Packing 1080i, 1080p (*1) Frame Packing The same as the input signal
 

*1 Specify 1080i 59.94, 1080i 60, 1080p 23.98, 1080p24, 1080p 29.97, 1080p 30, 1080i 50, or 1080p 

25. 

 

● Stop 

Stops the disparity measurement. You can also use the Stop button in the center of the 

screen or the SPACE key to stop the measurement. 
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● Capture 

Select the Capture menu item to capture the 3D video. You can also use the Capture 

button in the center of the screen to capture the video. When the Area Mode menu item is 

set to Select, you cannot select this menu item. 

After the LT 7030A captures the video, the disparity measurement is stopped, and the 

Detailed Analysis button in the center of the screen lights in orange. 
 

You can then click the Detailed Analysis button to analyze the captured data. On the 

Detailed Analysis screen, the captured data (1920 × 1080) is reduced to the 

measurement size that you have specified (the Analysis Size), and the disparity is then 

measured. 
 

In the top of the screen, the video for the left eye, the combined video (the depth display 

with no errors displayed), and the video for the right eye are displayed. If you double-click 

the video for the left eye or the video for the right eye, the video prior to reduction (1920 × 

1080) is displayed. If you double-click the combined video, a zoomed display of the 

combined video after reduction is displayed. To return to the normal display, double-click 

the screen. 
 

 
 

Analysis Size 

(Measurement size)(*1)

Horizontal Range Vertical Range (*2) 

480x270 3.3%, 6.7%, 10.0%, 13.3%, 16.7%, 20.0%, . . . 46.7% Auto, 1.0%, 2.0%, 

640x360 2.5%, 5.0%, 7.5%, 10.0%, 12.5%, 15.0%, . . . 35.0% 3.0%, 4.0%, 5.0%, 

960x540 1.7%, 3.3%, 5.0%, 6.7%, 8.3%, 10.0%, . . . 23.3% 10.0%, 15.0%, 

1280x720 1.3%, 2.5%, 3.8%, 5.0%, 6.3%, 7.5%, . . . 17.5% 30.0%, 50.0%, 

1920x1080 0.8%, 1.7%, 2.5%, 3.3%, 4.2%, 5.0%, . . . 11.7% 100.0% 
 

*1 When the input connector is HDMI and the 3D format is Side by Side(Half), you cannot select 

1920x1080. 

*2 100.0% indicates the total number of pixels. When you select Auto, 100.0% represents the disparity 

that occurs the most. 
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5.4.7 Histogram 

The structure of the Histogram menu is shown below. 
 

Histogram Normal

Color Map  
 

● Normal and Color Map 

You can select the histogram colors from the options shown below. 
 

Histogram Colors Explanation 

Normal The histogram is displayed with the colors that were shown in 

section 5.2, “Histogram Explanation.” 

Color Map Blue is used at +7.50 %, red is used at -7.50 %, and the values 

between these end points are displayed with a gradation. (When 

the Area Mode menu item is set to Select, the values between 

+1.87 % and -1.87 % are displayed with a gradation.) 

 

Normal 

 
 

Color Map 
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5.4.8 Area Mode 

The structure of the Area Mode menu is shown below. 

During disparity measurements, you cannot select the Area Mode menu. 
 

Area Mode Normal

Select  
 

● Normal and Select 

Select the disparity measurement range from the values shown below. 
 

Measurement Range Explanation 

Normal The disparity of all areas (1920 dots × 1080 lines) will be measured. 

The measurement resolution is 4 dots (approximately 0.21 %). 

Select The disparity of the selected area (480 dots × 270 lines) will be measured. 

The measurement resolution is 1 dot (approximately 0.05%). 

 

If you select the Select menu item and then begin the disparity measurement, a yellow 

frame will be displayed in the top of the screen. To move this frame, move the cursor over 

the video for the left eye. After you have selected the measurement area, double-click. 

Note that the disparity measurement is not performed while you are selecting the 

measurement area. 
 

 
 

The disparity of the selected area is displayed. “Area Select” is displayed in the upper 

right of the screen. 

If you want to change the selected area, during the disparity measurement, double-click the 

video for the left eye again to display the yellow frame. 
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5.4.9 Option 

The structure of the Option menu is shown below. 
 

Pre-set Clear

Screen Disparity dot

Excluding 0% Bar

Time Code Mode

Including 0% Bar

Time Code Source RP188

PC LocalTime

Limit Expression

Angle of Vergence °

Perceived Depth cm

Screen Disparity cm

VITC

Serial

Angular Disparity °

Overlay

Thumbnail

Option Synthesize Effect

Screen Disparity %

Convergence

Depth

Log

Graph Direction

Data Logging and Graph

Error Logging

Right to Left

Left to Right

Normal

Zero Start

Pre-set Start/Stop Error Logging Start Only

Stop Only

Start and Stop

Start and Stop

Start Only

Stop Only

Data Logging and Graph

 



5. AUTOMATIC 3D DISPARITY MEASUREMENT 

39 

● Synthesize Effect 

Select the display mode of the combined video, which is shown in the center of the screen, 

from the values shown below. 
 

Display Mode Explanation 

Depth(*1) In relation to the screen, the near parts of the video are displayed 

in white and the far parts of the video are displayed in black. When 

the upper disparity limits have been set, locations in which errors 

occur are displayed in red (for near parts) and blue (for far parts). 

Convergence The difference between the video for the left eye and the video for 

the right eye are displayed in monochrome. 

Overlay(*1) In relation to the screen, the near parts of the video are displayed 

in red and the far parts of the video are displayed in blue. The red 

and blue parts are overlayed on top of a monochrome version of 

the video for the left eye. If the upper disparity limits have not been 

set, only a monochrome version of the video for the left eye is 

displayed. 
 

*1 When the Histogram menu item is set to Color Map, the disparity portions are displayed with a 

gradation. 
 

Depth Convergence Overlay 

   
 

● Limit Expression 

Select from the following values the display format of Limit Near and Limit Far that are 

displayed at the bottom of the screen and of Near MaxDisparity and Far MaxDisparity that 

appear on the log display. 
 

Display Format Explanation 

Screen Disparity % The screen disparity is displayed as a percentage. This is the 

default setting. 

Screen Disparity cm The screen disparity is displayed in centimeters. 

This cannot be selected if the Parameter items have not been set. 

Screen Disparity dot The screen disparity is displayed in dots. 

Perceived Depth cm The near and far distances from the screen are displayed in 

centimeters. 

This cannot be selected if the Parameter items have not been set. 

Angle of Vergence ° The angle of vergence is displayed in degrees. 

This cannot be selected if the Parameter items have not been set. 

Angular Disparity ° The angular disparity is displayed in degrees. 

This cannot be selected if the Parameter items have not been set. 
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● Time Code Source 

Select the format of the time codes that are used in logging from the values shown below. 

During disparity measurements, you cannot select this menu item. 

When Time Code Mode is set to Zero Start, the disparity measurement start time is set to 

00:00:00 regardless of the time code that you select here. 
 

Format Explanation 

RP188 The PR188 time code embedded in the input signal is displayed. 

This is the default setting. 

VITC The VITC time code embedded in the input signal is displayed. 

Serial The time code embedded in the input signal is displayed. 

PC LocalTime The LT 7030A clock is displayed here. If you have set INPUT to 

HDMI on the File menu, PC LocalTime is selected automatically. 

 

● Excluding 0% Bar and Including 0% Bar 

With the default settings, the LT 7030A will measure 0 % disparities (no disparity). However, 

you can configure the LT 7030A so that it does not perform these measurements. 

To disable these measurements, click the Excluding 0% Bar menu item. The menu item will 

switch to Including 0% Bar, and 0 % disparities will no longer be measured. If you click the 

Including 0 % Bar menu item, the LT 7030A will measure 0 % disparities again. 
 

Enabled Disabled 

   

 

● Log - Error Logging 

You can configure the LT 7030A so that it logs the errors that occur during disparity 

measurements. 

To log errors, click the Error Logging menu item. When the text on this menu item is 

displayed in orange, the LT 7030A is configured to log errors. You can also click the Error 

Logging button in the center of the screen to log errors. 

If Near Limit and Far Limit have not been set on the Upper Limit menu or if Data Logging 

and Graph has been turned on, you cannot select this menu item. 

See section 5.4.4, “Upper Limit.” 
 

Off On 
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When you turn Error Logging on and press Start, the error log and the recording start time 

are displayed on the screen as shown below. 
 

 
 

Until you turn Error Logging off, the recorded error log is saved in the following log folder as 

a single piece of data. To view the saved error log, use the log viewer. 

See chapter 6, “LOG VIEWER.” 
 

 D 

└  LT7030A 

   └  Log 

      ├  yyyy-mm-dd-hh-mm-ss-log...................Log folder (when Area Mode is set to Normal) 

      └  yyyy-mm-dd-hh-mm-ss-log-Area..........Log folder (when Area Mode is set to Select) 

 

● Log - Data Logging and Graph 

You can configure the LT 7030A so that it logs all the frames that it measures during 

disparity measurements. You can also view a graph of the log with time on the horizontal 

axis and the maximum disparity on the vertical axis. 

To record the data log, click the Data Logging and Graph menu item. When the text on this 

menu item is displayed in orange, the LT 7030A is configured to record the data log. You 

can also click the Data Logging and Graph button in the center of the screen or press F1 to 

record the data log. 

If Error Logging is on, you cannot select this menu item. 
 

Off On 

   

 

When you turn Data Logging and Graph on and press Start, the time graph is displayed on 

the screen as shown below. 

Up to 600 frames are displayed on the time graph. Older graph data is deleted from the 

display, but after the measurement is complete, you can use the log viewer to view the 

entire graph. 

See chapter 6, “LOG VIEWER.” 
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Until you turn Data Logging and Graph off, the recorded data log is saved in the following 

log folder as a single piece of data. To view the saved data log, use the log viewer. 
 

 D 

└  LT7030A 

   └  Graph 

      ├  yyyy-mm-dd-hh-mm-ss-graph ..............Log folder (when Area Mode is set to Normal) 

      └  yyyy-mm-dd-hh-mm-ss-graph-Area......Log folder (when Area Mode is set to Select) 

 

● Log - Graph Direction 

Select from the values shown below the direction of the horizontal axis (time) of the time 

graph that is displayed when you turn Data Logging and Graph on. 

If Error Logging is on, you cannot select this menu item. 
 

Left to Right, Right to Left 
 

● Log - Thumbnail 

You can record the combined video together with the logs when they are recorded. 

To record the combined video, click the Thumbnail menu item. When the text on this menu 

item is displayed in orange, the LT 7030A is configured to record the combined video. You 

can also use the Thumbnail button in the center of the screen to turn on the recording of 

combined video. 
 

Off On 

   

 

Until you turn Error Logging or Data Logging and Graph off, the recorded combined video 

is saved in the following log folder as a single piece of data. To view the saved combined 

video, use the log viewer. 

See chapter 6, “LOG VIEWER.” 

 

● Log - Time Code Mode 

Select the logging time code mode. 

During disparity measurements, you cannot select this menu item. 
 

Format Explanation 

Normal Logs are recorded with the time code that you used Time Code 

Source to select. 

Zero Start The time code of the disparity measurement start time is set to 

00:00:00. 
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● Log - Pre-set Start/Stop 

You can configure the LT 7030A so that logging starts and stops at the specified times. 

During disparity measurements, you cannot select these menu items. 
 

To Start Logging at a Specified Time 

a) Set Time Code Mode to Normal. When Time Code Mode has been set to Zero Start, 

you cannot use this feature. Turn the Error Logging button and the Data Logging and 

Graph button off. 
 

b) Click Error Logging or Data Logging and Graph, and then click the Start Only menu 

item to enter the start time. Enter two digits for the time. 
 

 
 

When you click OK, the text on the Error Logging button or the Data Logging and 

Graph button changes to Pre-set Start. 
 

 
 

c) Click Start. The LT 7030A will start logging at the specified time. 
 

To Stop Logging at a Specified Time 

a) Click Error Logging or Data Logging and Graph, and then click the Stop Only menu 

item to enter the stop time. Enter two digits for the time.  

When Time Code Mode has been set to Zero Start, enter the time from the start of 

logging to the point where logging will stop. 
 

 
 

b) Click Start. 
 

c) Turn the Error Logging button or the Data Logging and Graph button on. (You can also 

turn these buttons on before pressing Start.) 

The text on the Error Logging button or the Data Logging and Graph button changes to 

Pre-set Stop. The LT 7030A will stop logging at the specified time. 
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To Start and Stop Logging at the Specified Times 

a) Set Time Code Mode to Normal. When Time Code Mode has been set to Zero Start, 

you cannot use this feature. Turn the Error Logging button and the Data Logging and 

Graph button off. 
 

b) Click Error Logging or Data Logging and Graph, and then click the Start and Stop 

menu item to enter the start and stop times. Enter two digits for the times. 
 

 
 

When you click OK, the text on the Error Logging button or the Data Logging and 

Graph button changes to Pre-set Start. 
 

 
 

c) Click Start. The LT 7030A will start and stop logging at the specified times. 
 

● Log - Pre-set Clear 

Clears the preset feature (starting and stopping logging at the specified times). 
 
5.4.10 Help 

The structure of the Help menu is shown below. 
 

Help Version Information  
 

● Version Information 

Displays the software version. 
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6. LOG VIEWER 

This chapter explains the log viewer feature, which is a part of the automatic 3D disparity 

measurement software. 
 

During disparity measurements, recorded logs are saved to the LT 7030A. You can use the log 

viewer to view these logs. In addition, by installing the log viewer on another PC, you can also 

view the log data on the other PC. 
 

To start the log viewer, on the File Menu, click Log Viewer. To run the log viewer on another PC, 

see section 6.2, “Installation.” 
 

6.1 Window Explanation 

 
 

1 Menu 

Performs file operations and configures various settings. 

See section 6.4, “Menu Explanation.” 
 

2 Log Folder Display 

Displays a list of the log folders that are saved in D:\LT7030A\Log or D:\LT7030A\Graph. 

You can use the File menu to change the folder location. 

When you have set the Area Mode menu item to Select in the automatic 3D disparity 

measurement, “-Area” is appended to the end of the folder name. 

See section 6.4.1, “File.” 
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3 Thumbnail Display 

Displays the combined video of the log that you select using “9 Log Data Display.” 

Use Synthesize Effect on the Option menu to select the display mode. 

To display the combined video, Thumbnail on the Option menu must be turned on so that 

thumbnails are recorded when logs are recorded. When thumbnails are turned off, “NO 

Thumbnail” is displayed, and the combined video is not displayed. 

See section 5.4.7, “Option.” 
 

4 Page Navigation Buttons 

Up to 1800 log data entries can be displayed per page. If there are 1801 data entries or 

more in a single file, click >> to move to the next page and << to move to the previous 

page. 
 

5 Status Display 

Displays the settings that were in use when the log was recorded. For information on the 

items not shown below, see section 5.1, “Window Explanation.” 
 

View Item Explanation 

Near Error Count Displays the number of near error occurrences in the 

selected log data entry. 

Error Log 

Far Error Count Displays the number of far error occurrences in the 

selected log data entry. 

All Data Log Frame Count Displays the number of frames that are recorded in the 

selected log folder. 
 

6 Histogram Display 

Displays the histogram of the log that you select using “9 Log Data Display.” 
 

7 Log Type Display 

Displays the type of log that has been selected on the View menu. 

See section 6.4.3, “View.” 
 

8 Area Select Display 

This is displayed when you use “2 Log Folder Display” to select a log folder that has 

“-Area” appended to it. 
 

9 Log Data Display 

Displays the contents of the log folder that you used “2 Log Folder Display” to select. 
 

10 Goto 

Up to 1800 log data entries can be displayed per page. If there are 1801 data entries or 

more in a single file, you can use the Goto box to go to the specified page. 
 

11 Slider 

Changes the threshold that has been set with Error Threshold on the Upper Limit menu. 

See sections 5.4.4, “Upper Limit,” and 6.4.5, “Option.” 
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6.2 Installation 

You can install the log viewer as standalone software on another PC. By doing so, you can 

view the log data that has been recorded on the LT 7030A on another PC. 
 

This section will show the procedure for viewing log data that has been recorded on the LT 

7030A on another PC. 

The other PC must meet the following system requirements. 
 

Item Requirement 

OS Windows 7, Windows XP SP3 

Memory 1 GB or more 

Hard disk 1 MB or more of free space (this does not include the space that 

is required to install Microsoft .Net Framework 3.5) 

Display 1024 × 768 or higher, high color, 32 bit 

 

1. Insert the included CD-ROM in the PC. 

2. Double-click “LT7030A Log Viewer Version 3.2 Installer.msi” on the CD-ROM. 

 CD-ROM 

└  LT7030A Log Viewer Version 3.2 Installer.msi 

 

3. Install Microsoft .NET Framework 3.5. 

If Microsoft .NET Framework 3.5 is not installed on the PC, the following window will be 

displayed. Click Yes to install the software. 

Follow the procedure provided by Microsoft to install the software. 
 

 
 

4. When the following window appears, click Next. 
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5. When the following window appears, click Next. 

 
 

6. When the following window appears, the installation is complete. Click Close. 

 
 

7. On the PC's D drive, create a “LT7030A” folder. In that folder, create a “Log” folder and a 
“Graph” folder. Copy the log folders from the LT 7030A to these folders. 

Copy the folders as a whole (do not copy individual files). 
 

PC 

 D 

└  LT7030A .......................................................Create this folder. 

   ├  Log ..........................................................Create this folder. 

   │ └  yyyy-mm-dd-hh-mm-ss-log(-Area) .....Copy the folders into this folder from the LT 7030A.

   └  Graph ......................................................Create this folder. 

      └  yyyy-mm-dd-hh-mm-ss-graph(-Area) .Copy the folders into this folder from the LT 7030A.
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8. Double-click “3D Assist Box Log Viewer” on the desktop. 

 
 

The Log Viewer window is displayed. 

Select a log folder in the upper left of the window to display the contents of the folder in 

the right side of the window. 
 

 
 

6.3 Uninstallation 

To uninstall the log viewer, on the taskbar, click Start, All Programs, LT7030A 3D Assist Box, 

and then Uninstall. Click Yes when the following dialog box appears. 
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6.4 Menu Explanation 

6.4.1 File 

The structure of the File menu is shown below. 
 

Without Leader Logo With Leader Logo

All Data Log

Export Error Log

Print Menu Print Selected Frame

Close

Print

Print Current Page

Print Preview

Print

Print ALL Page

Print

Print Preview

Print Preview

File

Select the Folder for Log

 
 

● Print Menu 

By connecting a printer to the LT 7030A, you can print log data as reports. Select the print 

format from the values shown below. Click Print Preview to see how it will be printed. Click 

Print to print the data. 
 

Print Format Explanation 

Print Selected Frame Only the log data that you selected in the log data display in the upper right 

of the screen will be printed. 

Print Current Page The currently displayed page of the log data that is contained in the log 

folder that you selected in the upper left of the screen will be printed. 

Print ALL Page All the log data that is contained in the log folder that you selected in the 

upper left of the screen will be printed. 

 

With “Print ALL Page,” a title page is printed before the log data. The values that you 

enter on the Contents Information screen will be printed on this title page. 
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● Without Leader Logo and With Leader Logo 

With the default settings, the “LEADER” logo is included in reports, but you can hide 

this logo. 

To hide the logo, click the Without Leader Logo menu item. The text on the menu item 

switches to “With Leader Logo,” and the logo is hidden. You can display the logo by 

clicking the With Leader Logo menu item. 

The setting that you specify here also affects the time graph analyzer reports. 

See section 6.5.3, “Report Screen Explanation.” 
 

Show Hide 

   

 

● Export - Error Log and Export - All Data Log 

Exports the data that is contained in the log folder that you selected in the upper left of the 

screen. The data is saved in csv format. 

You can use Microsoft Excel or a similar program to view the exported data. 
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● Select the Folder for Log 

Select the log folders that are displayed in the log viewer. 

In the factory default settings, the log folders in “D:\LT7030A” are displayed. 
 

 
 

● Close 

Closes the log viewer. You can also use the close button in the upper right of the screen to 

close the log viewer. 
 
6.4.2 Limit Expression 

The structure of the Limit Expression menu is shown below. 
 

Angle of Vergence °

Limit Expression Screen Disparity %

Screen Disparity cm

Screen Disparity dot

Perceived Depth cm

Angular Disparity °  
 

● Limit Expression 

Select the display format of Near Max and Far Max from the values shown below. 
 

Display Format Explanation 

Screen Disparity % The screen disparity is displayed as a percentage. This is the default setting.

Screen Disparity cm The screen disparity is displayed in centimeters. 

Screen Disparity dot The screen disparity is displayed in dots. 

Perceived Depth cm The near and far distances from the screen are displayed in centimeters. 

Angle of Vergence ° The angle of vergence is displayed in degrees. 

Angular Disparity ° The angular disparity is displayed in degrees. 
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6.4.3 View 

The structure of the View menu is shown below. 
 

All Data Log

View Error Log

 
 

● Error Log and All Data Log 

Switches the log type. 

Click Error Log to view the error logs that have been recorded during automatic 3D 

disparity measurement through the use of the Error Logging menu item. Click All Data Log 

to view the data logs that have been recorded during automatic 3D disparity measurement 

through the use of the Data Logging and Graph menu item. 
 
6.4.4 Analysis 

The structure of the Analysis menu is shown below. 
 

All Data LogAnalysis  
 

● All Data Log 

When the View menu item is set to All Data Log, click this to display an analysis of the data 

in the log folder that you selected in the upper left of the screen. 

See section 6.5, “Time Graph Analyzer.” 

 
6.4.5 Option 

The structure of the Option menu is shown below. 
 

Option Manual Threshold  
 

● Manual Threshold 

Changes the threshold that has been set with Error Threshold on the Upper Limit menu. 

Changes to the threshold can be viewed temporarily on the histogram. These changes are 

not applied to the thumbnails and error counts. If you switch to a different log, you will lose 

the changes that you have made to the threshold. 

See section 5.4.4, “Upper Limit.” 
 

To change the threshold, select a log, and then click the Manual Threshold menu item. 

When the menu item text is displayed in orange, you can use the slider in the lower right of 

the screen to change the threshold. 
 

OFF ON 
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6.4.6 Help 

The structure of the Help menu is shown below. 
 

Help Version Information  
 

● Version Information 

Displays the software version. 
 

 
 

6.5 Time Graph Analyzer 

When the View menu item is set to All Data Log, you can analyze the selected log folder by 

setting the Analysis menu item to All Data Log. 
 

There are the following three analysis screens: the time graph screen, the data screen, and 

the report screen. To switch between the screens, click Time Graph, Data Analysis, or Report 

in the upper left of the screen. 

“Area Select” is displayed in the upper right of the screen to indicate the times when a 

selected area was measured. 
 

 
 
6.5.1 Time Graph Screen Explanation 
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1 Complete Time Graph Display 

All the data is displayed on a graph with time as its horizontal axis (left to right) and 

maximum disparity as its vertical axis. 

Use the mouse to move the red box (which covers 150 frames). A magnified version of 

the indicated area is displayed below the complete time graph. Double-click the red 

box to fix its position. To make the box movable, double-click it again. 
 

2 Magnified Time Graph Display 

Displays a magnified version of the area that you selected with the red box as shown 

in “1 Complete Time Graph Display.” Time codes are displayed at the top of the 

graph. 
 

3 Disparity Search 

Select a disparity from the list, and then click Search to display the selected disparity in 

olive. Click Clear to clear this display. 
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6.5.2 Data Screen Explanation 
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1 Analysis Display (Per Disparity) 

Displays the total number of occurrences of each disparity as a count and as a 

percentage of the total number of disparities. 
 

2 Analysis Display (Overall) 

Displays the total number of occurrences of the following items as a count and as a 

percentage of the total number of occurrences of all items shown below. 
 

Item Explanation 

Near Over A near disparity, in relation to the screen, that exceeds the upper limit 

Near Normal A near disparity, in relation to the screen, that does not exceed the upper limit 

Far Normal A far disparity, in relation to the screen, that does not exceed the upper limit 

Far Over A far disparity, in relation to the screen, that exceeds the upper limit 

Near A near point in relation to the screen 

Far A far point in relation to the screen 

Over A disparity that exceeds the upper limit 

Normal A disparity that does not exceed the upper limit 

 

3 Maximum Occurrence Display 

Displays the maximum number of occurrences. The vertical axis uses the maximum 

number of occurrences as the upper limit of its full scale. 
 

4 Display of Selected Data 

Displays in olive on the graph the data that you selected using “1 Analysis Display.” 

The data is also displayed as values in the upper left of the graph. 
 

5 Histogram Color Selection 

Select the histogram colors. If you select “Color Map Histogram,” a gradation is 

used to display the histogram. 
 

6 Graph Display 

Displays a graph with disparity as its horizontal axis and total number of occurrences 

as its vertical axis. 
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6.5.3 Report Screen Explanation 

On the report screen, you can view and print the time graph as a report. 

If the LT 7030A cannot recognize the time codes, the time graph may not be displayed 

correctly. 
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1 Page Navigation Buttons 

Click >> to move to the next page and << to move to the previous page. 
 

2 Display and Print Reports 

Click Create Report to display a report. Click Print Report to print a report. A cover 

page is included as the first page of the report. The items that you entered on the 

Contents Information screen are printed on the cover page. 
 

 
 

Use the list to select the interval of the time graph's horizontal axis from the values 

shown below. If you select “one page,” the horizontal axis interval will be 

automatically adjusted so that the time graph fits on one page. 

After you select a value, click Create Report or Print Report to apply the change. 
 

1 sec, 2 sec, 5 sec, 10 sec, 30 sec, 1 min, 2 min, 3 min, one page 
 

3 Goto 

Click Goto to go to the selected page. 
 

4 LEADER Logo 

You can use the File menu in the log viewer to hide this logo. 

See section 6.4.1, “File.” 
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6.5.4 Menu Explanation 

The structure of the time graph analyzer screen's menu is shown below. 
 

Screen Disparity cm

Screen Disparity dot

Perceived Depth cm

Angle of Vergence °

File Close

Display Expression Screen Disparity %

Angular Disparity °  
 

● File - Close 

Closes the time graph analyzer. You can also use the close button in the upper right of the 

screen to close the time graph analyzer. 
 

● Disparity Expression 

Select the disparity display format from the values shown below. 

On the report screen, this value is applied when you click Create Report or Print Report. 
 

Display Format Explanation 

Screen Disparity % The screen disparity is displayed as a percentage. This is the default setting.

Screen Disparity cm The screen disparity is displayed in centimeters. 

Screen Disparity dot The screen disparity is displayed in dots. 

Perceived Depth cm The near and far distances from the screen are displayed in centimeters. 

Angle of Vergence ° The angle of vergence is displayed in degrees. 

Angular Disparity ° The angular disparity is displayed in degrees. 
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此标志适用于在中国销售的电子信息产品,依据2006年2月28日公布的

《电子信息产品污染控制管理办法》以及SJ/T11364-2006《电子信息产品污染

控制标识要求》，表示该产品在使用完结后可再利用。数字表示的是环境保护使

用期限，只要遵守与本产品有关的安全和使用上的注意事项，从制造日算起在数

字所表示的年限内，产品不会产生环境污染和对人体、财产的影响。

产品适当使用后报废的方法请遵从电子信息产品的回收、再利用相关法令。

详细请咨询各级政府主管部门。

产品中有毒有害物质或元素的名称及含量

部件名称             有毒有害物质或元素    Hazardous Substances in each Part

Parts 铅 汞 镉 六价铬 多溴联苯 多溴二苯醚

(Pb) (Hg) (Cd) (Cr(Ⅵ)) (PBB) (PBDE)

主体部 × ○ ○ ○ ○ ○

开关电源 × ○ ○ ○ ○ ○

风扇 × ○ ○ ○ ○ ○

外筐 ○ ○ ○ ○ ○ ○

附件 × ○ ○ ○ ○ ○

包装材 ○ ○ ○ ○ ○ ○

备注）

  ○：表示该有毒有害物质在该部件所有均质材料中的含量均在SJ/T11363-2006 规定的限量要求以下。 

  ×：表示该有毒有害物质或元素至少在该部件的某一均质材料中的含量超出SJ/T11363-2006 

  　　标准规定的限量要求。

Ver.1

  所含有毒有害物质信息

部件号码:

Following information is for Chinese RoHS only
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